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3D Nonlinear 
Analysis of a 
Concrete Beam 
For LUSAS version: 23.0 
For software product:  Any Plus version. Bridge Plus version for the modelling 

described in the discussion at the end. 
With product options: Nonlinear. 

Description 
A nonlinear plane stress analysis 
is to be carried out on a 3D model 
of a reinforced concrete beam.  

Two, 16mm diameter steel bars of 
reinforcement are provided in the 
top and lower faces of the beam, 
with 8mm diameter links provided 
throughout. The superposition of 
nodal degrees of freedom assumes 
that the concrete and 
reinforcement are perfectly 
bonded. It is assumed that the self-
weight of the beam is negligible 
compared with the applied load.  

Due to the symmetrical nature of the problem, only the left-hand span of the beam is 
modelled. The beam is simply supported at the left-hand end with a symmetry support 
at the right-hand axis of symmetry. A concentrated vertical load of 5000kN is applied 
to the top of the beam 1200mm from the left-hand end. The concrete section is 
represented by plane stress (HX8) elements, and the reinforcement bars are represented 
by parasitic bar (BRS3) elements. A nonlinear concrete cracking material model will be 
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applied to the plane stress elements, and a von Mises plastic material will be applied to 
the steel reinforcement bars.  

Note. This example shows the use of lines meshed with parasitic bar elements to 
model reinforcement. These lines can be defined independently of any other lines, 
surfaces or volumes that may be used to model concrete in 2D or 3D models. 

Units of N, mm, t, s, C are used throughout. 

Objectives 
The behaviour of the beam under cracking/yielding is to be examined by producing the 
following: 

 A Deformed Mesh Plot showing the final deformed shape. 
 A Load Displacement Graph for the top node on the axis of symmetry 

of the beam. 
 Stress contour plot showing the stress distribution in the beam. 
 Crack pattern plot showing the crack patterns produced. 
 Animation of stresses and crack patterns for selected load 

increments. 
 Stress contour plot showing the stresses in the reinforcement bars. 

 
Keywords 
3D, Inplane, Plane Stress, Parasitic Bar Elements, Nonlinear Concrete Model, 
Element Selection, Concrete Cracking, Steel Reinforcement, Groups, Crack 
Patterns, Animation, Graphing, Load Displacement Curve 

Associated Files 
Associated files can be downloaded from the user area of the LUSAS website. 

 3d_nl_beam_modelling.lvb carries out the modelling of the example. 
 
 

Modelling 

Running LUSAS Modeller 
For details of how to run LUSAS Modeller, see the heading Running LUSAS 
Modeller in the Introduction to LUSAS Worked Examples document. 

Note. This example is written assuming a new LUSAS Modeller session has been 
started. If continuing from an existing Modeller session select the menu command 

 

 

 
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File>New to start a new model file. Modeller will prompt for any unsaved data and 
display the New Model dialog. 

Creating a new model 
• Enter a File name of 3d_nl_beam 

• Use the default User-defined working folder. 

• Ensure an Analysis type of Structural is set. 

• Select an Analysis Category of 3D 

• Important: Set Model units of N,mm,t,s,C 

• Leave the Timescale units as Seconds 

• Select a Startup template of 3D Beam/Shell.  

• Ensure the Layout grid is set as None 

• Enter a Title of 3D Nonlinear Concrete Beam  

• Click the OK button. 

Note. Use the Undo button to correct any mistakes made since the last save was done. 

Set the vertical axis 
By default, 3D models in LUSAS are set-up with a vertical Z-axis. But this example 
requires a vertical Y-axis. 

• On the Model Properties dialog press the Y-axis radio button. 

Defining the Geometry 

 Enter coordinates of 
(0, 0), (1200, 0) and 
(1650, 0) to define two 
Lines representing the 
bottom of the left hand span of the beam. Click the OK button to finish. 

• Select both lines just drawn by dragging a selection box around them. 

 Enter a translation value of 300 in the Y direction to create the Surfaces which 
represent the side of the beam.  


  

Tools 
Vertical Axis…  

Geometry 
Line > 

By Coords...  

Geometry 
Surface > 

By Sweeping... 
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• Click the OK button. 

 

 

• Select the two surfaces just drawn 

 Enter a translation value of 200 in the Z direction to create the Volumes which 
represent the concrete beam.  

• Click the OK button. 

The model should appear as 
shown.  

Rotate the model to see a 
similar view. 

 

 

 

Defining and assigning the mesh for the concrete 
The concrete will be modelled using a volume mesh, using line mesh divisions to 
control the mesh density. 

• Nonlinear concrete is best modelled by HX8 elements. Select Element name and 
enter HX8.  

• Enter the attribute name as Stress linear 

• Click the OK button to add the attribute to the  Treeview. 

• Select the whole 
model and drag and 
drop the Stress 
linear mesh attribute 
onto the selection. 

The default mesh density 
of 4 divisions per line is 
sufficient for the 
volumes to the right of 
where the load will be applied. A graded line mesh will be created for use on the 
volumes to the left of where the load will be applied. 

 

Geometry 
Volume > 

By Sweeping... 

 

Attributes 
Mesh > 

Volume… 
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Defining a graded mesh 
• For an element type of None, change the Number of divisions to 6 and click the 

Spacing button. 

• Select a Uniform transition ratio of first to last element of 2 and click OK 

• Change the attribute name to Null, div = 6 graded 

• Click the OK button to finish to add the attribute to the  Treeview. 

• Select the 4 lines on 
the left-hand side of 
the model as shown 
and drag and drop the 
line mesh attribute 
Null, div = 6 graded 
from the  Treeview 
onto the selection. 

 

The mesh arrangement 
will be updated initially as 
shown right.  

This shows that the line 
direction of the lower line 
in the ‘front’ of the model 
will need to be reversed in 
order to obtain the desired 
mesh arrangement. 

 

To do this: 

• Select only the lower 
line at the ‘front’ of the 
model. 

The line direction will be 
reversed, and the mesh 
arrangement updated. 

 

 

Attributes 
Mesh > 

Line… 

 

 

 

Geometry 
Line > 

Reverse 
Direction… 
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Note. Line directions, and surface and volume axes can be viewed by visiting the 
Treeview and double-clicking on the Geometry entry and making appropriate 
selections. 

Defining the geometry for the reinforcement bars 
Bottom reinforcement bars: 
These will have 30mm cover at the left-hand end of the beam and extend to the mid-
point of the model on the right-hand side. Note that the position of the centreline of the 
bar is defined. 

 Enter coordinates of 
(30, 38, 38) and (1650, 
38, 38) to define the 
centreline of a single 
straight reinforcement 
bar in the bottom of the 
beam. 

 

• Select the line just drawn 

 Enter a Z value of 
124 and click OK. 

The other bottom bar will 
be created. 

 

 

 

 

Top reinforcement bars: 

• Select both lines representing the bottom bars of reinforcement 

 

Geometry 
Line > 

By Coords... 

 

Geometry 
Line > 

Copy… 

 

Geometry 
Line > 

Copy 
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 Enter a Y value of 
224 and click OK. 

The top bars will be 
created 

 

 

 

Defining links 
Links are required to start 75mm from the left-hand end of the beam, then spaced at 
150mm centres. One link will be defined initially, before being copied along the beam. 

• Press the Shift key +  to see the left-hand 
end view of the beam. (If the Shift key is not pressed, the 
other end of the beam would be incorrectly viewed 
instead.) 

 Enter x, y, z coordinates of (75, 24, 24), (75, 24, 176, 
24), (75, 276, 176) and (75, 276, 24) to define corner points 
that will be used to define the links. 

• Select the two points on the left-hand side that are yet to 
define a line. 

 This draws a line connecting the two selected points. 

 

Note. Depending upon the level of detail and accuracy of results, the link could be 
left without radiused corners, but in this example, radii will be added to represent the 
true shape of the link. 

 

 

Geometry 
Line > 

By Coords... 

Geometry 
Line > 

By Points... 

 
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 To add radii to the corners of the link: 

• Select two lines of the link that meet at a 
common point. 

• Enter a tangent radius of 16, accept all other 
defaults, and click OK.  

The unwanted lines that are left behind will be 
deleted after a radius has been added to the other 
three corners. 

• Repeat the above operation for the other 3 
corners of the link to see the image shown 
right. 

To remove unwanted lines: 

• Select the 8 unwanted remaining lines that are 
present in each corner and press the Delete 
key. Click Yes All to confirm. 

 To copy the link defined: 

• Select the 8 remaining lines defining the link  

 Ensure Translate is selected, enter an X value 
of 150 with the number of copies set to be 10 and 
click OK. 

 

 

 

 

 

 

Rotate the model to see the generated links. 

 

Geometry 
Line > 

Arc/Circle > 
Tangent to 
Lines… 

 

Geometry 
Line > 

Copy… 
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Defining Groups 
To simplify the assignment of model attributes certain model features will be grouped 
together to allow selection by name in the  Treeview as opposed to selection by 
cursor in the view window.  This is easiest done by viewing a side view of the model. 

• Press the Z-axis  button to see a side view of the beam 

 

• First, select only 
the two volumes 
representing the 
concrete. 

 Enter Concrete for the group name and click OK. 

• Now box-select 
only the two sets 
of two lines that 
represent the top 
and bottom bar 
reinforcement. Take care with the box-selections to not to include the lines 
representing the transverse legs of links. Use the Shift key to add to the initial 
selection. 

 
Geometry 

Group > 
New Group 
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 Enter Main reinforcement for the group name and click OK. 

•  Change the 
selection cursor 
to select only 
Lines 

• Now box-select only the lines representing the links. See preceding image. 

 Enter Links for the group name and click OK. 

 Change the selection cursor back to selecting all items. 

Note. Model attributes will now be defined but they will not be assigned to the model 
straight away. They will be assigned to the model later by making use of the Groups 
facility. 

Defining the bar reinforcement mesh 
The reinforcement bars will be modelled using a parasitic bar elements. These sit 
wholly within a host element. The line mesh spacing along the line to which the 
attribute is assigned is determined by the intersection of the line and the faces of the 
host elements through which the line or lines pass. The numbers of elements along each 
line may be adjusted if required. 

• Set element type to Parasitic bar and Interpolation order to Quadratic. 

• Press the Spacing button and set the Minimum number of element divisions to be 
2. Leave other settings as their defaults and click OK. 

• Enter the attribute name as Bar, quadratic and click OK to add the attribute to the 
 Treeview. 

Defining the top and bottom reinforcement bar size 
• Select From library / calculator and then from the adjacent droplists select 

Parametric Sections then Circular Sections then New…  

• Enter a diameter, D, of 16 and click OK to accept the default utility name 

• Back on the Geometric line dialog enter the attribute name as 16 dia bar and click 
the OK button to add the attribute to the  Treeview. 

Geometry 
Group > 

New Group 

 

Geometry 
Group > 

New Group 

 

Attributes 
Mesh > 

Line… 

Attributes 
Geometric > 

Line… 
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Defining the link bar size 
• Select From library / calculator and then from the adjacent droplists select 

Parametric Sections then Circular Sections then New…  

• Enter a diameter, D, of 8 and click OK to accept the default utility name 

• Back on the Geometric line dialog enter the attribute name as 8 dia bar and click 
the OK button to add the attribute to the  Treeview. 

Defining the material properties 
Steel 
Nonlinear steel properties will be defined for the bar elements representing the 
reinforcement. 

• Enter Young's modulus as 210e3 and Poisson's ratio as 0.3 and leave the mass 
density field blank. 

• Select the Plastic check box, and then select the Plastic tab and enter an Initial 
uniaxial yield stress of 300 

• Select the Hardening option, click the Hardening gradient button and enter a 
hardening Slope value of 2121 with a Plastic strain of 1 

• Enter the attribute name as Nonlinear Steel 

• Click the OK button to add the attribute to the  Treeview. 

Concrete 
Nonlinear concrete material properties will be defined for the volume elements 
representing the concrete. 

• Ensure the concrete model Smoothed multi-crack (model 109) is selected. 

• Ensure that Creep model code None is selected. 

• Ensure that Shrinkage model code None is selected. 

• Select the Strain at end of softening curve radio button to add a row containing a 
default value to the grid and accept all the remaining default values. 

• Enter the attribute name as Nonlinear Concrete 

• Click the OK button to add the attribute to the  Treeview. 

Attributes 
Geometric > 

Line… 

Attributes 
Material > 

Isotropic… 

Attributes 
Material > 

Concrete 
(Nonlinear)… 
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Assigning concrete material to the model 
The material and geometric attributes and parasitic line mesh attributes defined 
previously will now be assigned to the model using the groups that have been defined. 

• In the  Treeview right-click the group name Concrete. Select the Select 
Members option. Click Yes if necessary to de-select any previously selected 
items. 

• Drag and drop the material attribute Nonlinear Concrete from the  Treeview 
onto the selected features. Ensure the Assign to volumes option is selected for 
Analysis 1 and click OK 

 

Assigning attributes to the main reinforcement 
• In the  Treeview right-click the group name Main reinforcement. Select the 

Select Members option. The line features in the group will be highlighted. 

• Drag and drop the mesh attribute Bar, quadratic from the  Treeview onto the 
selected features. Click OK. 

Note. There will be a short pause whilst the line mesh divisions for the bars are 
calculated for each intersection with the concrete mesh 

• Drag and drop the geometric attribute 16 dia bar from the  Treeview onto the 
selected features. Click OK. 

• Drag and drop the material attribute Nonlinear Steel from the  Treeview onto 
the selected features. Click OK. 

 

Now that the parasitic line mesh and bar geometry have been assigned, the fleshed size 
of the reinforcement can be seen. 

 
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Assigning attributes to the link reinforcement 
• In the  Treeview right-click the group name Links. Select the Select Members 

option. The line features in the group will be highlighted. 

• Drag and drop the mesh attribute Bar, quadratic from the  Treeview onto the 
selected features. Click OK. 

Note. There will be a short pause whilst the line mesh divisions for the links are 
calculated for each intersection with the concrete mesh 

• Drag and drop the geometric attribute 8 dia bar from the  Treeview onto the 
selected features. Click OK. 

• Drag and drop the material attribute Nonlinear Steel from the  Treeview onto 
the selected features. Click OK. 

 

When the model is rotated the reinforcement cage can be seen. 

 

Notes about the parasitic line mesh assigned 
The intersection of the parasitic bar meshed lines and the host volume element mesh 
determines fixed nodal locations on the parasitic line that cannot be modified, however 
additional elements may be added by using the line mesh spacing options available. 

 
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• Press the Shift key +  to see the left-hand end view of the beam. 

By setting the parasitic spacing parameter earlier to use a minimum number of 2 
quadratic elements the link shape will match the left-hand image that follows. 

Otherwise, by default, a single quadratic element would be used to represent each 
radiused corner of the link. When fleshed, these would appear as shown on the right-
hand image that follows. 

  

With parametric spacing set to a 
minimum number of 2 

With default values for parametric 
spacing  

Note. Increasing the number of parasitic line mesh elements will noticeably increase 
the time required to mesh any changes to the model. 

Supports 
The beam is to be simply supported in the Y direction at its left-hand end and 
supported by a horizontal restraint in the X direction at its right-hand side to satisfy the 
symmetry requirements at mid-span. 

• Press  to view the model from the side as shown below. 

• Box-select the lowest 
point at the left hand 
end of the model as 
shown. (This will 
ensure that the line to 
which the support 
will be assigned is also selected.) 

 
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• Drag and drop the support attribute Fixed in Y from the  Treeview onto the 
selection. Ensure the Assign to lines and All analysis loadcases options are 
selected and click OK 

• Box-select around the line at the right-hand end of the model (as shown on the 
previous image). This will ensure that the surface to which the support will be 
assigned is also selected. 

• Drag and drop the support attribute Fixed in X from the  Treeview onto the 
selection. Ensure the Assign to surfaces and All analysis loadcases options are 
selected and click OK 

 

Loading 
A load is to be applied to the line at the top of the beam. A unit load will be applied and 
the load factor in the nonlinear control will be used to control the magnitude of loading. 

• Rotate the model to a 
similar view as shown. 

• Select the line on the 
top of the beam as 
shown. 

 

 

• Select a load type of Distributed loads of type Global distributed and click Next 

• Enter a Total load of -5000 for the Y direction 

• Enter a name of Distributed total load and click OK. 

• Drag and drop the loading dataset Distributed total load from the  Treeview 
onto the selected line and click OK to assign the load to Analysis 1, Loadcase 1. 

 

Attributes 
Loading... 
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Nonlinear Control 
Nonlinear analysis control properties are defined as properties of a loadcase. The 
nonlinear analysis is to be terminated when the beam deflection at mid-span reaches a 
limiting value. 

• Select the point shown 
(which represents the 
mid-point of the 
actual beam). 

• In the  Treeview 
ensure the Analysis 1 
entry is expanded, 
then right-click on 
Loadcase 1 and from 
the Controls menu select Nonlinear & Transient 

The Nonlinear & Transient dialog will appear: 

 

• Select the Nonlinear option and set Incrementation to Automatic 

• The load to be applied to the model is the concentrated load previously defined and 
assigned to the model multiplied by the starting load factor. Set the Starting load 
factor to 0.01 to apply a minute amount of load initially. 
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• Ensure the Max change in load factor is set as 0 to signify that no limit and let 
Solver uses load factors according to how the solution is progressing. 

• Change the Max total load factor to 0 because the solution is to be terminated 
once the limiting displacement at mid span has been reached for a particular 
loading increment. 

• Ensure the number of Iterations per increment is set as 4 

Note. If the number of iterations on the previous increment is less than the desired 
number, the next load increment will be increased (up to the maximum change in load 
increment). If the number of iterations is less than the desired number, the next load 
increment will be reduced. 

• Leave the other settings as shown on the previous dialog image. The residual force 
norm value of 0.1 means that the convergence of the solution at each load 
increment will be achieved when the out of balance forces are as less than 0.1% of 
the reactions. 

• In the Incrementation section of the dialog, select the Advanced button. 

 

• Ensure that Incrementation by arc-length control is Off. 

• For termination criteria select the Terminate on value of limiting variable 
option. The point number of the previously selected point will appear in the Point 
number drop down list. (This may differ from the number shown above depending 
on how the model was created.) 

• Set the Variable type to V to monitor the deflection at the selected point in the Y 
direction. 

• Enter a value of -3 (minus three) so the analysis is terminated when the loading 
increment that causes this central deflection exceeds this value. 

 
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• In the Step reduction section ensure that the Allow step reduction option is 
selected. 

• Click OK to return to the Nonlinear & Transient dialog. 

• Click OK again to set the loadcase properties. 

One additional setting is required for this analysis to ensure no element mechanisms are 
induced as the material yields. 

• Select the Options tab. 

• Click on the Element Options button and select the Fine integration for stiffness 
and mass (Structural) option. 

• Click the OK button to return to the Model Properties dialog.  

• Click the OK button to finish. 

Save the model 
The model is now complete, and the model data is to be saved before an analysis is run 
using the LUSAS Solver.  

 Save the model file. 

Running the Analysis 
 Open the Solve Now dialog and press OK to run the analysis. 

During the analysis 2 files will be created: 

 3d_nl_beam.out this contains the statistics of the analysis, for example how 
much disk space was used, how much CPU time was used, and any errors or 
warning messages from LUSAS, and so on. Always check the LUSAS output 
file for error messages. 

 3d_nl_beam.mys this is the LUSAS results database which will be used for 
results processing. 

 
Note. Warnings will be written to the text output window during this analysis. 
Warnings are not to be confused with errors which normally stop an analysis from 
being run. The warnings are written to advise you of modelling-related issues that are 
found during the analysis and of the steps LUSAS has taken (if any) to allow the 
analysis to continue. 

File 
Model Properties… 

File 
Save 

 
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If the analysis is successful... 
Analysis loadcase results are added to the  Treeview. 
 

If the analysis fails... 
If the analysis fails, information relating to the nature of the error encountered can be 
written to an output file in addition to the text output window.  Select No to not view 
the output file.  Any errors listed in the text output window should be corrected in 
LUSAS Modeller before saving the model and re-running the analysis.  

Rebuilding a Model  
If it proves impossible for you to correct the errors reported a file is provided to enable 
you to re-create the model from scratch and run an analysis successfully.  You may 
download a zip file containing this file from the user area of the LUSAS website. 

3d_nl_beam_modelling.lvb carries out the modelling of the example. 
 

 

 Start a new model file. If an existing model is open Modeller will prompt for 
unsaved data to be saved before opening the new file. 

• Enter the file name as 3d_nl_beam 

• Use the default User-defined working folder. 

• Ensure an Analysis category of 3D is set. 

• Click the OK button. 

Note. There is no need to enter any other new model details when a script is run to 
build a model, since the contents of the script will overwrite any other settings made. 

 To recreate the model, select the file 3d_nl_beam_modelling.lvb that was downloaded 
and placed in a folder of your choosing. 

 Rerun the analysis to generate the results. 

Viewing the Results 
Analysis loadcase results are present in the  Treeview. 

 
File 

New… 

 
File 

Script > 
Run Script... 
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Changing the Active Results Loadcase 
• In the  Treeview the last load increment Increment 10 Load Factor = 5.3500 

should be already Set Active. 

Deformed Shape 
• In the  Treeview turn off the Geometry and Mesh layers by right clicking on 

each entry and selecting the On/Off option. 

To see the supports and loading arrows in the correct location on a deformed mesh plot: 

• In the  Treeview double-click on the Attributes entry, click the Supports tab, 
and select From results file. Click the Loading tab and click From results file. 
Click OK. 

Creating a Load versus Displacement Graph 
A graph of displacement at 
mid-span is to be plotted 
against the applied load.  

• Ensure the node on 
the line of symmetry 
is still selected: 

• With the Deformed 
mesh layer visible, 
select the top edge node on the axis of symmetry as shown. 

Using the Graph Wizard 
The graph wizard provides a step-by-step means of selecting which results are to be 
plotted on the X and Y axes of the graph. The X axis is always defined first. 

• Ensure the Time history option is selected and click the Next button. 

• Ensure the Nodal results is selected and click Next 

• Select entity Displacement for component resultant displacement DY 

• The node number selected earlier will be displayed in the Specify drop-down list. 

• Click the Next button. 

The Y axis results to be graphed are now defined. 

• Select the Named option and click Next 

 

Utilities 
Graph Wizard... 
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• Select Total load factor from the drop down list. 

• Click the Next button. 

• Leave all title 
information blank and 
click the Finish button 
to display the load 
deformation graph. 

From the graph and its 
adjacent data table it can be 
seen that for the final load 
increment that needed to be 
considered, a displacement 
of -3mm the corresponding 
load factor is around 4.25 

Note. Graphs can be modified using the right hand mouse button in the graph 
window and selecting the Edit Graph Properties option.  

 Close the graph window. 

• In the  Treeview turn off the Deformed mesh layer and turn on the Mesh layer. 

Maximum Principal Stress Contour Plots 
• With no features selected, click the right-hand mouse button in an empty part of 

the view window and select the Contours option to add the contours layer to the 
 Treeview. 

The properties dialog will be displayed. 

• Select entity Stress - Solids, Component of stress in the x direction, Sabs, and 
Averaged nodal contours. 

• Click the OK button to display contours of stresses for the final load increment. 

 

 
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Viewing Crack Patterns 
• With no features selected, click the right-hand mouse button in an empty part of 

the view window and select the Values option to add the values layer to the  
Treeview. 

The properties dialog will be displayed. 

• Select Stress - Solids contour results of type Crack/Crush 

• Click the OK button to display the cracking pattern (no crushing is present) for 
final load increment superimposed onto the stress contours 
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Animating the Results 
As an alternative to viewing results individually for each loadcase, the change of stress 
due to the increasing load increments can be animated instead. To ensure consistent 
contour values throughout the animation the interval, and the maximum and minimum 
values for the range of contours is to be specified. 

• In the  Treeview double-click on the Contours layer.  

The contour properties will be displayed. 

• Select the Appearance tab and for the Classic contour range press the Set button 

• Click the Interval option and set the contour interval as 2 

• Click the Maximum button and set the maximum value as 6 

• Click the Minimum button and set the minimum value as -20 

• Click the OK button to return to the parent dialog, and OK to redisplay the stress 
contours using the new contour range. 

Using the Animation Wizard 
• Select the Load History option and click the Next button.  

• Select the All loadcases option and select the Finish button to create the animation 
sequence. 

Tools 
Animation Wizard... 



3D Nonlinear Analysis of a Concrete Beam 

 24 

 

Note. The buttons at the bottom of the window may be used to slow-down, speed-up, 
pause, step through frame by frame, or stop the animation. 

Note. To see the animation window in isolation use the Window > Layout > 
Multiple documents menu option. 

Saving Animations 
Animations may be saved for replay in Windows animation players. 

• Ensure the animation window is the active window. 

• Browse to your projects folder and enter 3d_nl_beam for the animation file name. 
An .avi file extension is automatically appended to the file name. Click OK. 

Note. Animations can be compressed to save disk space by changing the 
Compression Quality. Reducing the quality will, however, result in a lower definition 
image. It is also possible to reduce file size by setting smaller dimensions on the first 
page of the Animation Wizard. 

 Close the animation window, choosing not to save changes. 

Plotting Crack Width Contours  
Crack width values as calculated by the use of the Smoothed multi-crack concrete 
model can be plotted in contour and value form: 

 
 

File 
Save As  AVI... 

 
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• Double-click the Contours layer name in the   Treeview. 

The properties dialog will be displayed. 

• Select entity Concrete Results - Solids for component of stress in the x direction, 
CWMax, and of Unaveraged nodal results. 

• Select the Appearance tab and for the Classic contour range press the Set button 

• Deselect the Maximum button. 

• Deselect the Minimum button. 

• Set the contour Interval to be 0.05 

• Ensure the Value to pass through is set to be 0 

• Click the OK button on both dialogs to redisplay the stress contours using the new 
contour range. 

• Press Yes to confirm the Values layer will be adjusted to match. 

• Press the Z-axis button  at the bottom of the view window to view the 
model from along the z-axis. 

 

Note. Contouring of unaveraged nodal results effectively shows the elements affected 
by cracking and identifies those elements where the maximum crack widths occur.  

To see the actual values of crack width within elements (at the locations where the 
Crack/crush patterns were plotted earlier in the example), values for gauss points need 
to be plotted. 

• Double-click the Contours layer name in the   Treeview and on the dialog 
select entity Concrete Results - Solids for component of stress in the x direction, 
CWMax, and of Gauss point results. And click OK.  

 
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• Press Yes to confirm the Values layer will be adjusted to match. 

 

Plotting crack width values 
• Double click the Values layer name in the  Treeview. 

• Select the Values Display tab, ensure that both the Symbols and Values options 
are checked, ensure only Maxima is selected, to show the top 10% of results. 
Leave the font angle set to 0 degrees.  

• Click OK to update the display and show the actual crack width values calculated 
at gauss points within the element.  

 

•  Zoom-in if you wish to see more detail. 

Plotting stress in the reinforcement 
• Double click the Contours layer name in the  Treeview. 

• Select entity Stress – Bar and component Sx(Fx) 
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• Click Yes to update the Values layer to match. 

•  Ensure that fleshing is turned on to see the contours drawn on the true size of 
the reinforcement. 

 

This completes the example. 
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